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1. Introduction 
 

1.1 Add-on Module STEEL 
STEEL is not a stand-alone program. STEEL is one of the add-on modules integrated in the 
graphical user interface of the main program RSTAB. Due to the integration, all structure-
specific input data as well as the internal forces are automatically available in the STEEL 
module. In return, you can evaluate the design results in the RSTAB work window graphical-
ly and include them in the global printout report. 

STEEL performs general stress designs by calculating existing stresses and comparing them 
with the limit stresses. The program provides a comprehensive cross-section library as well 
as an expandable material library with standard-specific limit stresses. For each cross-
section, design relevant stress points that can also be used for graphical evaluations are al-
ready available. 

During the stress analysis process, the program determines also the maximum stresses of 
sets of members and shows the governing internal forces for each member. In addition, 
STEEL offers you an automatic cross-section optimization including an export option for 
modified cross-sections to RSTAB. 

Different STEEL design cases allow for a flexible analysis of stresses. The design is completed 
by a parts list with quantity surveying. 

The following useful features facilitate the work with the STEEL add-on module: 

• Display of maximum stress ratios in the cross-section table helping you to decide how 
to optimize the cross-section 

• Connection between STEEL tables and RSTAB work window, thus it is possible to select 
active objects in the background graphic 

• View mode for modifying the view in the RSTAB work window 

• Colored relation scales in results tables 

• Info icon for successful or failed stress design 

• Representation of STEEL stresses and ratios in the form of result diagrams 

• Filter options for the stresses displayed in the RSTAB graphic 

• Display of stresses and stress ratios on rendered model 

• Export of modified materials to RSTAB 

• Data export to MS Excel and OpenOffice.org Calc or as a CSV file 

Therefore, STEEL is the appropriate program for general stress analyses. However, stability 
analyses, as required for example in DIN 18000 part 2 or EN 1993-1-1, cannot be per-
formed. To analyze the stability of a structure, use the add-on modules KAPPA, LTB or STEEL 
EC3. 

We hope you will enjoy working with the add-on module STEEL. Your comments and sug-
gestions are always welcome. 

Your team from ING.-SOFTWARE DLUBAL 
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1.2 STEEL Team 
The following people were involved in the development of STEEL: 

Program coordination 
Dipl.-Ing. Georg Dlubal 
 Dipl.-Ing. (FH) Younes El Frem 

Programming 
Ing. Zdeněk Kosáček 
Mgr. Petr Oulehle 
David Schweiner 

Ing. Roman Svoboda 
Dis. Jiří Šmerák 
Lukáš Tůma 

Cross-section and material database 
Ing. Ph.D. Jan Rybín  
Jan Brnušák 

Program design, dialog figures and icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Ing. Jan Miléř 

Program supervision 
Ing. Martin Vasek 
Petr Pražák 

Michala Sobotková 
Ing. František Knobloch 

Manual, help system and translation 
Dipl.-Ing. (FH) Robert Vogl 
Ing. Dmitry Bystrov 
Jan Jeřábek 
Ing. Ladislav Kábrt 

Mgr. Michaela Kryšková 
Dipl.-Ü. Gundel Pietzcker 
Mgr. Petra Pokorná 

Technical support and quality management 
Dipl.-Ing. (BA) Markus Baumgärtel 
Dipl.-Ing. (BA) Sandy Baumgärtel 
Dipl.-Ing. (FH) Steffen Clauß 
Dipl.-Ing. (FH) Matthias Entenmann 
Dipl.-Ing. Frank Faulstich 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Stefan Frenzel 
Dipl.-Ing. (FH) Walter Fröhlich 
Dipl.-Ing. (FH) Andreas Hörold 

Dipl.-Ing. (FH) Bastian Kuhn 
M.Sc. Dipl.-Ing. Frank Lobisch 
Dipl.-Ing. (FH) Alexander Meierhofer 
M.Eng. Dipl.-Ing. (BA) Andreas Niemeier 
M.Eng. Dipl.-Ing. (FH) Walter Rustler 
M.Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Christian Stautner 
Dipl.-Ing. (FH) Robert Vogl 
Dipl.-Ing. (FH) Andreas Wopperer 
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1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation and printout are de-
scribed in detail in the manual of the main program RSTAB. The present manual focuses on 
typical features of the STEEL add-on module. 

The descriptions in this manual follow the sequence of the module's input and results tables 
as well as their structure. The text of the manual shows the described buttons in square 
brackets, for example [Apply]. At the same time, they are pictured on the left. Expressions 
appearing in dialog boxes, tables and menus are set in italics to clarify the explanations. 

At the end of the manual, you find the index. However, if you don’t find what you are look-
ing for, please check our website www.dlubal.com where you can go through our FAQ 
pages by selecting particular criteria. 

1.4 Open the Add-on Module STEEL 
RSTAB provides the following options to start the add-on module STEEL. 

Menu 
To start the program in the menu bar, 

point to Design - Steel on the Additional Modules menu, and then select STEEL. 

 
Figure 1.1: Menu: Additional Modules → Design - Steel → STEEL 
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Navigator 
To start STEEL in the Data navigator, 

select STEEL in the Additional Modules folder. 

 
Figure 1.2: Data navigator: Additional Modules → STEEL 

Panel 
In case STEEL results are already available in the RSTAB structure, you can set the relevant 
STEEL design case in the load case list of the RSTAB toolbar. Maybe you have to activate the 
graphical results display first, showing the stresses and design ratios by using the button 
[Results on/off]. 

When the results display is activated, the panel is available, too. To access the add-on mod-
ule quickly, use the panel button [STEEL]. 

 

Figure 1.3: Panel button [STEEL] 
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2. Input Data 
All data required for the definition of design cases is entered in tables. The [Pick] button al-
lows for a graphical selection of the members and sets of members that you want to de-
sign. 

When you have started the add-on module, a new window opens where a navigator is dis-
played on the left, managing all available tables. The pull-down list above the navigator 
contains the design cases (see chapter 7.1, page 51). 

If you open STEEL in an RSTAB structure for the first time, the module will import the fol-
lowing design relevant data automatically: 

• Members and sets of members 

• Load cases, load groups and load combinations as well as super combinations 

• Materials 

• Cross-sections 

• Internal forces (in background, if calculated) 

To select a table, click the corresponding entry in the STEEL navigator or page through the 
tables by using the buttons shown on the left. You can also use the function keys [F2] and 
[F3] to select the previous or subsequent table. 

Click [OK] to save the entered data and quit the add-on module STEEL. When you click 
[Cancel], you quit the module but without saving the data. 

2.1 General Data 
In table 1.1 General Data, you select the members, sets of members and actions that you 
want to design. The design standard will be specified in table 1.2 because the material 
properties are related to the standard. 

 
Figure 2.1: Table 1.1 General Data 
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Design of 
The design can be carried out for Members as well as for Sets of Members. If you want to 
design only selected objects, clear the All check boxes. Then you can access the input fields 
to enter the numbers of the relevant members or sets of members. To select the objects 
graphically in the RSTAB work window, use the [Pick] button. The list of the object numbers 
preset in the field can be selected quickly by double click and overwritten by entering the 
data manually. 

In case you have not yet defined any sets of members in RSTAB, you can create them in the 
STEEL module by clicking the [New] button. The dialog box that you already know from 
RSTAB appears where you can specify the data for a new set of members. 

When you design sets of members, STEEL determines the maximum stress ratio of all mem-
bers contained in the set of members. Subsequent to the analysis, the results are shown in 
table 2.2 Stresses by Set of Members, 3.2 Governing Internal Forces by Set of Members and 
4.2 Parts List by Set of Members. 

Existing Load Cases / Load Groups and Load Combinations 
The two dialog sections list all load cases, load groups and load combinations as well as su-
per combinations defined in RSTATB that are relevant for the design. Dynamic load cases, if 
available, are listed, too. Use the button [] to transfer selected entries to the list Selected 
for Design on the right. You can also double-click the items. To transfer the complete list to 
the right, use the button []. 

Load cases that are marked by an asterisk (*), like case 8 and 9 in Figure 2.1, cannot be de-
signed. This happens when you haven't defined any loads or when the load case contains 
only imperfections as shown in the example. 

Furthermore, STEEL is able to design super combinations and dynamic load cases from the 
add-on module DYNAM. 

Selected for Design 
The column on the right lists the loads selected for the design. Use the button [] to re-
move selected items from the list. You can also double-click the entries. With the button 
[], you can transfer the entire list to the left. 

The design of an enveloping "Or" load combination is often performed more quickly than 
the analysis of all actions that have been globally set. On the other hand, the influence of 
the actions contained in such a total CO are less transparent. Therefore, it is recommended 
to check the Method of Stress Calculation for load combinations in the Details dialog box 
(see chapter 3.1, page 18). 

Comment 
In this input field, you can enter user-defined notes describing in detail, for example, the 
current design case. 

2.2 Materials 
The table is subdivided into two parts. In the upper part, the materials defined in RSTAB are 
listed with their limit stresses. In the Material Properties section below, the properties of the 
current material, i.e. the table row currently selected in the upper section, are displayed. 

Materials that won't be used in the design appear gray in color. Materials that are not al-
lowed are highlighted red. Modified materials are displayed in blue. 

The material properties required for the determination of internal forces in RSTAB are de-
scribed in detail in chapter 5.2 of the RSTAB manual. The design relevant material properties 
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are stored in the global material library. They are preset automatically but can be adjusted 
in the present table. 

To adjust the units and decimal places of material properties and stresses, select Units and 
Decimal Places in the module's Settings menu (see Figure 7.10, page 56). 

 
Figure 2.2: Table 1.2 Materials 

Material Description 
The materials defined in RSTAB are already preset. When you modify the material descrip-
tion and the manually entered material name corresponds to an entry of the material li-
brary, STEEL will import the material properties that are required for the design. 

You can also modify the material by using the list: Place the pointer in a table row of col-
umn A, and then click the button [] or use the function key [F7] to open the list shown on 
the left. When you have selected a new material, the design relevant properties are entered 
into the remaining fields of the corresponding table row. 

Only Steel materials are available in the list. You can choose among various steel grades of 
different standards and codes for steel construction. In principle, you can carry out the de-
sign with any material whose stress concept is based on the comparison of existing normal, 
shear and equivalent stresses with the respective allowable stresses (for example the design 
of cross-sections consisting of aluminum  or stainless steel). Of course, you must take into 
account the respective standard specifications additionally. 

If you have set a material whose limit stresses are not defined (for example timber), the en-
try is highlighted in red. It is possible, however, to define the limit stresses by ticking the 
check box Manually in column D and entering user-defined specifications. The red color 
disappears as soon as you have defined the allowable stresses in the columns E to G. 

The import of materials from the library is described later. 
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Safety Factor γM 

This factor describes the safety factor used to calculate the design values of the material 
stiffnesses. Therefore M is indicated. By means of the factor γM the characteristic value of 
the yield strength fyk is reduced in order to determine the limit normal stress σR,d (see Equa-
tion 2.1) and the limit shear stress τR,d (Equation 2.2). 

Thus, for example for DIN 18800, the factor γM is considered twice for the design if the cal-
culation is carried out according to the second-order or the large deformation analysis: Ac-
cording to DIN 18800 part 2, el. (116), you must take into account the influence of defor-
mations by a stiffness that is reduced about 10 % when determining internal forces. More-
over, you must reduce the design values of the stiffnesses by the partial safety factor γM 
when you design the ultimate limit state. 

Yield Strength fyk 

The yield strength describes the limit to which the material can be strained without plastic 
deformation. The characteristic values of several steel grades can be found for example in 
DIN 18800 part 1, section 4 and EN 1993-1-1, section 3. 

Limit Stresses 
The limit stresses of materials that are stored in the general material library are preset au-
tomatically. These entries provide no access for modifications. 

If you want to adjust the limit stresses, you can use the [Edit Material] button (see Figure 
2.4, page 14). You can also use the check box Manually in column D. 

Manually 

If the check box is ticked, you can define the limit stresses in the columns E to G manually. 

Modified material properties are marked by an asterisk in the column Material Description. 

Limit σx 

The limit normal stress represents the allowable stress for actions due to bending and axial 
force. According to DIN 18800 part 1, el. (746), it is determined by the characteristic value 
of the yield strength, reduced by the partial safety factor γM. 

M

yk
d,R,x

f
γ

=σ  

Equation 2.1 

Limit τ 
The limit shear stress indicates the allowable shear stress due to shear and torsion. 
According to DIN 18800 part 1, el. (746), the partial safety factor γM is also taken into 
account by the equation used to determine the limit shear stress. 

3

f

M

yk
d,R

⋅γ
=τ  

Equation 2.2 

Limit σeqv 

The limit equivalent stress represents the allowable equivalent stress for the simultaneous 
effect of several stresses. According to DIN 18800 part 1, el. (746), it is determined by 
Equation 2.1.  
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Yield strength depending on thickness of structural components 
For some materials, there is a relation between the characteristic yield strength fy,k and the 
thickness t of the relevant structural component. The Max. Structural Thickness of the indi-
vidual ranges together with the corresponding yield strength is indicated in the dialog sec-
tion Material Properties below. 

The zones of the yield strength are specified in the standards, for example DIN 18800 part 
1, table 1. Use the [Edit Material] button to check and adjust, if necessary, the structural 
thicknesses and the assigned stresses (see page 14).  

Material Library 
Numerous materials are already available in the library. To open the corresponding dialog 
box, 

select Material Library on the Edit menu 

or use the button shown on the left. 

 
Figure 2.3: Dialog box Material Library 

In the Filter Choice section, Steel is preset as material category. Select the steel grade that 
you want to use for the design in the list Material to Select. The corresponding properties 
can be checked in the dialog section below. 

Click [OK] or use the [↵] button to import the selected material to table 1.2 of the add-on 
module. 

Chapter 5.2 of the RSTAB manual describes in detail how materials can be filtered, added or 
rearranged. By using the [Create New Material] button, you can create new types of steel 
with user-defined material properties and store them for later use. 

When you select another material category than Steel, be aware that you can design only 
materials whose stress concept is based on the comparison of existing normal, shear and 
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equivalent stresses with the respective allowable stresses. Therefore, it would be possible, 
with some restrictions, to design cross-sections consisting of aluminum or stainless steel. 

If you have set a material whose limit stresses are not defined (for example timber), the en-
tries of the corresponding table row in table 1.2 will be highlighted in red. However, you 
can define the limit stresses by ticking the check box Manually in column D and entering 
user-defined specifications. The red color disappears as soon as you have defined the allow-
able stresses in the columns E to G. Please note that designs, for example for timber cross-
sections, won't be performed completely: Timber standards require further criteria imple-
mented in the add-on module TIMBER Pro. 

Edit Material 
The yield strengths and limit stresses of the currently selected material can be adjusted by 
clicking the button shown on the left. The following dialog box appears: 

 
Figure 2.4: Dialog box Edit Material 

By means of the factor γM in the dialog section Safety Factor you can reduce the characteris-
tic values of the yield strength fyk defined in column C in the dialog section below. The limit 
stresses determined according to Equation 2.1 and Equation 2.2 on page 12 are listed in 
the columns D to F. 

In the dialog section Yield Strengths and Limit Stresses Subject to Component Thicknesses, 
you can change the ranges of the component Thickness t. The number of ranges is preset 
conforming to standards. You can shift the limits for the ranges by entering values manual-
ly in column B. Column A will be adjusted automatically. For each range, you can assign a 
specific Yield Strength fyk. 

To define the limit stresses individually, tick the check box User-defined, Independent Defi-
nition of Limit Stresses. Then you can access column D to F to enter user-defined data. 

Modified material properties are marked by an asterisk in table 1.2. 
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2.3 Cross-sections 
This table lists the cross-sections that are relevant for the design. In addition, the table al-
lows for the definition of optimization parameters. 

 
Figure 2.5: Table 1.3 Cross-sections 

Cross-section Description 
The cross-sections used in RSTAB are preset together with the assigned material numbers. 

It is always possible to modify the cross-sections for the design. The description of a mod-
ified cross-section is highlighted in blue. A cross-section that is not allowed to be used (for 
example a solid cross-section) is highlighted by red letters. 

To modify a cross-section, enter the new cross-section description directly into the corres-
ponding table row. You can also select a new cross-section from the library. To open the li-
brary, use the button [Import Cross-section from Library] below the table. Alternatively, 
place the pointer in the respective table row and click the [...] button, or use the function 
key [F7]. The RSTAB cross-section library, or the cross-section table of the input field, ap-
pears. 

The selection of cross-sections from the library is described in detail in chapter 5.3 of the 
RSTAB manual. 
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Figure 2.6: Cross-section Library 

If the STEEL cross-sections are different from the ones used in RSTAB, both cross-sections 
are displayed in the graphic in the right part of the table. The stress analysis will be per-
formed with the internal forces from RSTAB for the cross-section selected in STEEL. 

Member with tapered cross-section 

For tapered members with different cross-sections at the member start and member end, 
the module displays both cross-section numbers, in accordance with the definition in 
RSTAB, in two table rows. 

STEEL also designs tapered members provided that the cross-section at the member's start 
has the same number of stress points as the cross-section at the end of the member: The 
normal stresses, for example, are determined from the second moments of area and the 
centroidal distances of the stress points. If the start and the end cross-section of a tapered 
member have not the same number of stress points, the intermediate values cannot be in-
terpolated. Then, the rendering in RSTAB will display the cross-sections each to the middle 
of the member, but a calculation won't be possible, neither in RSTAB nor in STEEL. 

 
Figure 2.7: Warning in case of incompatible cross-sections 

To check the data, you can display the cross-section's stress points including numbering in 
the cross-section graphic to the right. For more information on stress points, see chapter 
4.1 on page 27. 

It is important for the design to have the same number of stress points. To produce the 
same number, you can create the second cross-section by copying the start cross-section 
and adjusting the geometry parameters. If required, you define both cross-sections as pa-
rameterized ("Welded") cross-sections. With the cross-section group I-Section Plus Lower 
Flange, the library provides cross-sections especially used for tapers. 
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Max. Design Ratio 
This column is intended to be a decision support for the optimization process. It will be dis-
played as soon as a design has been carried out. By means of the displayed design ratio and 
colored relation scales, you can see which cross-sections are hardly utilized and thus over-
sized, or extremely stressed and thus undersized. 

Optimize 
Each cross-section can be improved by an optimization process. By means of the internal 
forces of RSTAB, the program determines the cross-section of the cross-section table that 
comes as close as possible to the maximum stress ratio specified in the Details dialog box 
(see Figure 3.1, page 18). 

If you want to optimize a cross-section, tick the corresponding check box in column C or D. 
Recommendations for optimizing cross-sections can be found in chapter 7.2 on page 53. 

Remark 
This column shows remarks in the form of footers that are described in detail below the 
cross-section list. 

Remark 6) Incorrect cross-section data! Members of this cross-section will not be designed. 
indicates an unknown cross-section, which means a section that is not registered in the 
cross-section database. This may be a user-defined cross-section, or a SHAPE-THIN cross-
section that has not yet been calculated. In such a case, switch to RSTAB and specify the 
settings for the Stress Points (see chapter 5.3 of the RSTAB manual, section Create User-
defined Cross-sections). 

Cross-section graphic 
In the right part of table 1.3, a graphic of the currently selected cross-section is displayed. 
To adjust the size of the cross-section's graphical representation, use the zoom function 
(wheel button of the mouse device). 

The buttons below the cross-section graphic are reserved for the following functions: 

 

 
Table 2.1: Buttons of cross-section graphic 

Button Function 

 Opens the dialog box Info about cross-section showing the cross-section details. 

 Displays or hides the dimensions of the cross-section. 

 Displays or hides the principal axes of the cross-section. 

 Displays or hides the stress points. 

 Displays or hides the numbering of stress points. 

 Resets the full view of the cross-section graphic. 
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3. Calculation 
To start the calculation, click the [Calculation] button that is available in all input tables. The 
stress analysis is carried out by using the internal forces determined in RSTAB. Before you 
start the calculation, it is recommended to check the calculation parameters. 

3.1 Calculation Details 
To check the calculation parameters, use the [Details] button to open the following dialog 
box that can be accessed from any table in the module. 

 
Figure 3.1: Dialog box Details 

Display Result Tables 
This dialog section controls the display of the results tables including parts list. The different 
results tables are described in chapter 4. 

Table 2.5 Stresses at Every Stress Point is inactive by default because the stress graphic also 
can provide an appropriate evaluation of the results in the stress points. For a detailed table 
check of stresses, however, you may activate the display of this table. 

The values displayed in table 3.1 Governing Internal Forces are normally related to the 
equivalent stress σeqv. If required, you can use the list to select another stress type. 

Consider Plastification 
Allow Local Plastification 

If a Local Plastification according to DIN 18800 part 1, el. (749) is allowed for the design, 
the equivalent stress σeqv may exceed the allowed limit stress by 10 % in small areas. 

STEEL checks if both conditions mentioned in el. (749) are fulfilled for the assumption of 
"small areas". 
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d,RMN 8.0
y

σ⋅≤σ+σ  

Equation 3.1 

d,RMN 8.0
z

σ⋅≤σ+σ  

Equation 3.2 

If the conditions are fulfilled, the limit stress for the design of σeqv will be increased appro-
priately. 

Plastic Shape Factors αpl 

According to DIN 18800 part 1, el. (750) stresses can be reduced by Plastic Shape Factors 
αpl. This reduction refers to the normal stresses σM due to the bending moments My and Mz. 

y
zz,pl

z
z

yy,pl

y
M e

I
M

e
I

M
⋅

⋅α
±⋅

⋅α
±=σ  

Equation 3.3 

If you use this plastification option, STEEL applies the plastic shape factors αpl,y = 1.14 and 
αpl,z = 1.25 which are suggested in the standard. The allowance of local plastification is ap-
plied exclusively to rolled I-shaped cross-sections. 

Calculation of Equivalent Stress Sigma-eqv 
In this dialog section, you can adjust the factors for the determination of the equivalent 
stress. 

2
total2

2
total1eqv ff τ⋅+σ⋅=σ  

with  f1: factor for normal stresses 

  f2: factor for shear stresses 

Equation 3.4 

The program presets the factors f1 = 1.0 and f2 = 3.0. which are mentioned in DIN 18800 
part 1, el. (748). 

Method of Stress Calculation for Load Combinations 
A biaxial loading in different load cases may result in the fact that the combined member 
internal forces do not produce the maximum stresses. This is the case, for example, when 
the first load case with vertical load has only My moments but no Mz moments, and the 
second load case with horizontal load has only Mz moments but no My moments. If both 
load cases will be superimposed with the "Variable" setting in a load combination, RSTAB 
will display the moment Mz as not related to the maximum moment My in table 3.1 Mem-
bers - Internal Forces: The horizontal load does not contribute to the increase of the mo-
ment due to vertical load. If these CO internal forces are designed according to the maxi-
mum moments My and Mz separately, the program does not take into account the simulta-
neous influence of both internal forces for the combined analysis of the bending stresses. 

Stresses from Internal Forces 

The calculation method Stresses from Internal Forces uses the result rows of the RSTAB ta-
ble 3.1 Members - Internal Forces. The max/min results are processed row by row. Thus, the 
program determines the stresses for each extreme value together with the corresponding 
internal forces. 
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The advantage of this type of calculation is that the results of the load combinations can be 
used directly. This has a positive impact on the speed of the calculation. In addition, the de-
signed internal forces become transparent because in the STEEL table 3.1 Governing Inter-
nal Forces by Member the module displays the result rows from the RSTAB results table 3.1 
Members - Internal Forces. 

Calculate Stresses from Single Load Cases and then Combine 

This type of calculation is preset to calculate the stresses of load combinations. The pro-
gram determines the normal and shear stresses of the contained load cases and superim-
poses them subsequently according to the specified CO combination criteria. In this way, 
the program ensures that the effects described above, in case of bending stresses that are 
each uniaxial, do not result in stress ratios that are too low. 

The analysis is performed for each stress point: The compression, tension and shear stresses 
determined for the individual load cases are summed up according to the CO superposition 
criterion and displayed subsequently in the results tables. 

The equivalent stress σeqv represents an exception because it is determined by the compo-
nents of σtotal and τtotal. A superposition of equivalent stresses from the single load cases 
would not be correct and would result in stress ratios which are too high. 

This type of calculation requires more computing time. Furthermore, the values displayed in 
table 3.1 Governing Internal Forces are more difficult to understand, in case they refer to 
the equivalent stresses. 

As pure uniaxial bending usually does not occur in complex spatial systems, both calcula-
tion methods are normally supposed to show the same stress ratios in the output. 

Cross-section Optimization 
In case the optimization is not targeted on the maximum stress ratio of 100 %, you can 
specify another limit value in this input field. 

Eccentric Transverse Loads on I-Beams 
If transverse loads are introduced on the upper flange of beams, their influence on the 
bending stress in the lower flange decreases with the increasing cross-section depth. This is 
the reason why it is possible to consider eccentrically acting transverse loads by a simplified 
method for high I-sections: For each(!) rolled or welded symmetrical I-section that is set for 
design in the current STEEL case, the stress due to the bending moment Mz is calculated on-
ly on the upper flange. In such a case, the program uses an equivalent cross-section with 
half of the moment of inertia Iz. 

The advantage of this option is that you can enter the loads in the RSTAB model in relation 
to the centroidal axes in order to avoid torsion. 

As the ticked check box affects all symmetrical I-sections of the design case, it is recom-
mended to design the high I-beams in a separate STEEL case. 

The button [Preset of Default Values] resets the program's presettings. 
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3.2 Stresses and Ratio 
The normal stresses σtotal, τtotal and σeqv are displayed as presettings in the tables 2.1 to 2.5. 
To display the individual stress components, use the buttons [Select Stresses to Show] and 
[Extended Stress Diagram]. 

Normal stresses 
According to the common conventions, tensile stresses are indicated by positive signs and 
compressive stresses by negative signs. 

The analysis is carried out for each single stress point. Therefore, the components of the 
maximum stresses must not be summed up for a combined calculation (for example σtotal). 
Often, the maximum stresses occur at different stress points. You have to superimpose the 
stress components of the respective stress point. 

The normal stresses σ have the following meanings: 

σN 

Stress due to axial force N 

A
N

=σ  

where A: cross-sectional area of cross-section 

σM-y 

Stress due to bending moment My 
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where αpl,y: plastic shape factor acc. to DIN 18800 part 1, el. (750) 
 Iy: second moment of area related to principal axis y 
 ez: centroidal distance of stress point in direction z 

σM-z 

Stress due to bending moment Mz 
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where αpl,z: plastic shape factor acc. to DIN 18800 part 1, el. (750) 
 Iz: second moment of area related to principal axis z 
 ey: centroidal distance of stress point in direction y 

σM 
Stress due to bending moments My and Mz 
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σtension 

Tensile stress due to axial force N and bending moments My and Mz 
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σcompression 

Compressive stress due to axial force N and bending moments My and Mz 
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σdelta 
Maximum difference between normal stresses of different load cases that are 
required, for example, for the fatigue design 

σtotal 

Normal stress due to axial force N and bending moments My and Mz 
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Table 3.1: Normal stresses σ 
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The local member axis system has a certain impact on the signs of the internal forces and 
stresses. 

 
Figure 3.2: Positive definition of internal forces  

The bending moment My is positive if tensile stresses are produced on the positive member 
side (in direction of the z-axis). Mz is positive if compressive stresses occur on the positive 
member side (in direction of the y-axis). The sign definition for torsional moments, axial 
forces and shear forces conforms to the usual conventions. These internal forces are positive 
if they act in a positive direction. 

Shear stresses 
The shear stresses τ have the following meanings: 

τV-y 

Stress due to shear force Vy 

tI

QV

z

zy

⋅

⋅
−=τ  

where Qz: statical moment of area related to principal axis z 

 Iz: second moment of area related to principal axis z 

 t: governing thickness of cross-section 

τV-z 

Stress due to shear force Vz 

tI

QV
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⋅

⋅
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where Qy: statical moment of area related to principal axis y 

 Iy: second moment of area related to principal axis y 

 t: governing thickness of cross-section 

τV 

Stress due to shear forces Vy and Vz 
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τM-T, St.Venant 

Stress due to torsional moment MT in case of open cross-section 

t
J
M

.V.St

T ⋅=τ  

where JSt.V.: Saint Venant torsional constant 

 t: governing thickness of cross-section 
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τM-T, Bredt 

Stress due to torsional moment MT in case of closed cross-section 

tA2
M

m

T

⋅⋅
=τ  

where Am: area enclosed by the center lines of the cross-section 

 t: governing thickness of cross-section 

τM-T 
Stress due to torsional moment MT 

t
J
M

.V.St

T ⋅=τ   or  
tA2

M

m

T

⋅⋅
=τ  

τtotal 
Shear stress due to shear forces Vy and Vz and torsional moment MT 

TMV τ+τ=τ  

Table 3.2: Shear stresses τ 

As the equations show, the program uses the static moments instead of

For shear stresses due to torsion, please note the following: 

 the shear areas of 
the cross-section to determine the shear stresses due to shear force. 

• If you have a cross-section that is partially open but has one closed cell, the program 
will classify the entire cross-section as closed. In this case, the shear stress will be de-
termined exclusively according to the Bredt formula. Thus, STEEL won't perform any 
pro-rata analysis for MT,St.Venant and MT,Bredt like it is done in the cross-section module 
SHAPE-THIN. 

• The influence of the warping torsion is not considered in STEEL. The design, like the 
determination of internal forces in RSTAB, is exclusively limited to the primary torsional 
moment. However, if you have to consider warping stresses due to the secondary tor-
sional moment or the warping bimoment, it is recommended to use the add-on mod-
ule FE-LTB for the analysis. 

Equivalent stress 
The equivalent stress σeqv, for example according to DIN 18800 part 1, el. (748), is deter-
mined as follows: 

σeqv 

Equivalent stress from normal stresses σ and shear stresses τ 

2
total2

2
total1eqv ff τ⋅+σ⋅=σ  

where f1: factor for normal stresses 

 f2: factor for shear stresses 

Table 3.3: Equivalent stress σeqv 

The factors f1 and f2 can be defined in the Details dialog box where f1 = 1.0 and f2 = 3.0  
are preset according to DIN 18800 part 1, el. (748). 

Stress ratio 
For stress designs, as described for example in DIN 18800 part 1, el. (747), STEEL determines 
the quotient from the existing and the limit stress. 

For each internal force component, you can display the cross-section's stress ratio on the re-
spective stress point (see chapter 5.1, page 37). The ratios due to normal, shear and equiva-
lent stress are displayed in the table output by default. 
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If the limit stress is not exceeded, the ratio is less than or equal to 1.00 and the stress de-
sign was carried out successfully. 

1
d,R
≤

σ
σ

 

Equation 3.5: Design condition for normal stresses 

1
d,R
≤

τ
τ

 

Equation 3.6: Design condition for shear stresses 

1
d,R

v ≤
σ
σ

 

Equation 3.7: Design condition for equivalent stresses 

3.3 Start Calculation 
To start the calculation, click the [Calculation] button that is available in all input tables of 
the STEEL add-on module. 

STEEL searches for the results of the load cases, load groups and load combinations that 
should be designed. If they cannot be found, the program starts the RSTAB calculation to 
determine the design relevant internal forces. In this determination process, the calculation 
parameters preset in RSTAB are applied. 

If cross-sections should be optimized (see chapter 7.2, page 53), the program determines 
the required cross-sections and calculates the stresses. 

It is also possible to start the calculation for STEEL results in the RSTAB user interface. The 
add-on modules are listed like load cases and load groups in the dialog box To Calculate. To 
open the dialog box in RSTAB,  

select To Calculate on the Calculate menu. 

 
Figure 3.3: Dialog box To Calculate 
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If the STEEL design cases are missing in the Not Calculated list, tick the check box Show Ad-
ditional Modules below the list. 

To transfer the selected STEEL cases to the list on the right, use the button []. Start the 
calculation by using the [Calculate] button. 

You can also use the list in the RSTAB toolbar to calculate a design case directly: Select the 
STEEL case and click the button [Results on/off]. 

 
Figure 3.4: Direct calculation of a STEEL design case in RSTAB 

Subsequently, you can observe the calculation process in a separate dialog box. 

 
Figure 3.5: STEEL calculation 
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4. Results 
 

Table 2.1 Stresses by Cross-section is displayed immediately after the calculation. The tables 
2.1 to 2.5 show the stresses and ratios according to various criteria. The subsequent tables 
3.1 to 4.2 display the governing internal forces as well as the parts lists in relation to mem-
bers and sets of members. Use the STEEL navigator to access the relevant results table. You 
can also use the two buttons shown on the left or the function keys [F2] and [F3] to select 
the previous or subsequent table. 

Click the [OK] button to save the results. The add-on module STEEL will be closed and you 
will return to the RSTAB work window. 

Chapter 4 Results describes the different results tables one after the other. Evaluating and 
checking results is described in detail in chapter 5 Results Evaluation on page 36. 

4.1 Stresses by Cross-section 

 
Figure 4.1: Table 2.1 Stresses by Cross-section 

The table shows the maximum stress ratios of all members selected for the design, resulting 
from the internal forces of the governing loads or combinations. The results are listed by 
cross-sections. 

The stress components displayed in column E Stress Type refer to the settings selected in 
the dialog box Stresses - Filter (see Figure 5.3, page 37). To open the dialog box, use the 
button shown on the left. 

Member No. 
For each cross-section and each stress type, the table shows the number of the member 
with the maximum stress ratio. 
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Location x 
The column shows the respective x-location on the member for which the maximum value 
of stress has been determined. For the table output, the program uses the following RSTAB 
member locations x: 

• Start and end node 
• Partition points according to possibly defined member division 
• Member division according to specification for member results (Options tab of RSTAB 

dialog box Calculation Parameters) 
• Extreme values of internal forces 

S-Point No. 
The design is carried out on certain stress points of the cross-section. These points on the 
cross-section are defined by centroidal distances, static moments and cross-section thick-
nesses. Due to these cross-section properties, the design according to Table 3.1 and Table 
3.2 is possible. 

All default cross-sections of the library as well as the SHAPE-THIN and SHAPE-MASSIVE 
cross-sections are already provided with stress points on the design relevant cross-section 
locations. The parameters for user-defined cross-sections must be imported or defined ma-
nually. 

The dialog graphic on the right shows the stress points including numbering. The active 
stress point (that means the stress point of the table row where the pointer is placed) is 
highlighted in red. 

To check the stress point's properties, use the button [Info about Current Cross-section]. 
First, the dialog box Info about cross-section opens showing the list of the section proper-
ties. At the bottom right below the dialog graphic, you find the button [Details of Stress 
Points] that provides access to further stress point information. 

 
Figure 4.2: Info about cross-section: Stress Points 
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The columns Coordinates y and z show information about the centroidal distances ey and 
ez. The columns Statical Moments of Area Qy and Qz list the first moments of area in relation 
to the principal axis y or z. Thickness t represents the component thickness at the corres-
ponding stress point. The values contained in the Warping columns are not relevant for the 
design carried out with STEEL. 

The stress analysis is carried out for each single stress point so that normally the compo-
nents of the maximum stresses must not be summed up for the combined calculation (for 
example σeqv): Often, the maximum stresses occur at different stress points. You have to 
superimpose the stress components that are available on the same stress points. Table 2.5 
(see chapter 4.5, page 31), for example, or the window Cross-section Values and Stress Dia-
gram (see Figure 5.5, page 39) allow you to evaluate the results by stress points. 

Load Case 
Column D displays the numbers of the load cases, load groups and load combinations 
whose internal forces cause the respective maximum stresses. 

Stress Type 
The normal stresses σtotal, the shear stresses τtotal and the equivalent stresses σeqv are listed 
by default. The determination of these stresses is shown in Table 3.1, Table 3.2 and Table 
3.3 on page 21 to 23. 

You can display all stress components affecting the total stresses in order to check the data 
(see Figure 4.3). The individual stress components can be selected in the dialog box Stresses 
- Filter (see Figure 5.3, page 37). To access the dialog box, use the button shown on the 
left. 

Stress Existing 
This column displays the extreme values of the existing stresses determined according to the 
equations of Table 3.1, Table 3.2 and Table 3.3 shown on page 21 to 23. 

For unsymmetrical cross-sections such as L-sections in 2D systems, please note the follow-
ing: As member rotation angles are only available for 0° and 180°, only the component in 
direction of the member axis y will be taken into account for the division of moments. The 
component about z is not applied in a 2D system. Therefore, STEEL designs only the mo-
ment about the y-axis. It is recommended to define cross-sections, that are stressed not on-
ly in direction of the principal axis y, as spatial 3D models. This is the only way how the 
stresses can be determined correctly. 

Stress Limiting 
This column shows the limit stresses of table 1.2 (see chapter 2.2, page 10). In particular, 
they are the following: 

• Limit normal stress σx as the allowable stress for actions due to bending and axial force 

• Limit shear stress τ as the allowable shear stress due to shear and torsion 

• Limit equivalent stress σeqv as the allowable equivalent stress for the simultaneous ef-
fect of normal and shear stresses 

Stress Ratio 
For each stress component, STEEL determines the quotient from the existing and the limit 
stress. If the limit stress is not exceeded, the ratio is less than or equal to 1.00 and the stress 
design was carried out successfully. 

The colored scales represent the stress ratios of each cross-section. 

 

 

2D systems with 
unsymmetrical 
cross-sections 



4 Results 

 29 Program STEEL © 2011 Ing.-Software Dlubal 

 

4.2 Stresses by Set of Members 

 
Figure 4.3: Table 2.2 Stresses by Set of Members 

This table lists the maximum stress ratios sorted by sets of members. Details on the table 
columns can be found in the previous chapter 4.1. The table column Member No. shows 
the number of the member that bears the maximum stress ratio within the set of members. 

The results output by sets of members clearly presents the stress design for an entire struc-
tural group (for example a frame). 
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4.3 Stresses by MemberStresses 

 
Figure 4.4: Table 2.3 Stresses by Member 

This table lists the maximum stresses and stress ratios sorted by member numbers. The dif-
ferent columns are described in detail in chapter 4.1 on page 26. 

If a taper is used, both cross-section descriptions are displayed. 

4.4 Stresses by x-Location 

 
Figure 4.5: Table 2.4 Stresses by x-Location 
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This results table lists the maximum stresses of each member at the locations x resulting 
from the divisions defined in RSTAB: 

• Start and end node 
• Partition points according to possibly defined member division 
• Member division according to specification for member results (Options tab of RSTAB 

dialog box Calculation Parameters) 
• Extreme values of internal forces 

4.5 Stresses at Every Stress Point  

 
Figure 4.6: Table 2.5 Stresses at Every Stress Point 

This results table is set inactive by default because a results evaluation by stress points is on-
ly required in exceptional cases. To display the table, tick the corresponding check box in 
the Details dialog box (see Figure 3.1, page 18). To open the dialog box, use the [Details] 
button shown on the left which is available in all tables. 

The table manages a large amount of data. As STEEL determines the maximum stresses au-
tomatically, and thus the governing stress points, you usually do not need the display of ta-
ble 2.5. In addition, the tables 2.1 to 2.4 provide appropriate evaluation options by clicking 
the button [Cross-section Values and Extended Stress Diagram]. The dialog box Cross-
section Values and Stress Diagram opens (see Figure 5.5, page 39) where you can check the 
results of every single stress point graphically and numerically. 

The stresses in table 2.5 are listed for each member according to Location x and S-Point No. 
(stress point). The different columns of this table are described in detail in chapter 4.1 on 
page 26. 
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4.6 Governing Internal Forces by Member 

 
Figure 4.7: Table 3.1 Governing Internal Forces by Member 

This table displays for each member the governing internal forces resulting in maximum 
stress ratios. The output refers to the equivalent stress σeqv by default. In the Details dialog 
box (see Figure 3.1, page 18) that can be opened by using the [Details] button, you can 
change the reference for the output of the governing internal forces and set another stress 
component. 

If you Calculate Stresses from Single Load Cases in CO and then Combine Stresses according 
to CO Criteria, you prevent to evaluate the result rows of the RSTAB table 3.1 Members - In-
ternal Forces directly. Instead, the compressive, tensile and shear stresses available in the 
single load cases will be summed up respectively. The equivalent stress σeqv will be deter-
mined by the components of σtotal and τtotal. For this reason, in case of load combinations, 
you can retrace the internal forces displayed in table 3.1 only by retroactive calculation. 

Location x 
The column shows the respective x-location where the member's maximum stress ratio oc-
cur. 

Load Case 
This column indicates the numbers of the load case or load group, load combination or su-
per combination whose internal forces result in the maximum stress ratio on the member. 

Forces / Moments 
For each member, the governing normal and shear forces as well as the torsional and bend-
ing moments are displayed. 
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4.7 Governing Internal Forces by Set of 
Members 

 
Figure 4.8: Table 3.2 Governing Internal Forces by Set of Members 

This result table is displayed when sets of members have been selected for design. The in-
ternal forces that result in the maximum stress ratios are shown for each set of members. 
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4.8 Parts List by Member 
The output is completed by a parts list. 

 
Figure 4.9: Table 4.1 Parts List by Member 

By default, the list contains only the designed members. If you want to display a parts list 
with all members of the structure, select the corresponding option in the Details dialog box 
(see Figure 3.1, page 18). To open the dialog box, use the [Details] button shown on the 
left. 

Part No. 
The program assigns automatically part numbers for similar members. 

Cross-section 
This column lists the cross-section numbers and descriptions. 

Number Members 
This column shows for each part how much similar members are used. 

Length 
This column displays the length of an individual member. 

Tot Length 
This column shows the product that is determined from the two previous columns. 

Surf. Area 
The program indicates the surface area of the respective parts in relation to the total length. 
The surface area is determined from the Surface of the cross-sections. You can find the rele-
vant entry in the cross-section information, available in table 1.3 to 2.5 (see Figure 4.2, 
page 27). 
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Volume 
The volume of a part is determined from the cross-sectional area and the total length. 

Unit Weight 
The Unit Weight of the cross-section represents the mass in relation to the length of one 
meter. For tapered cross-sections, the program averages both cross-section properties. 

Weight 
The values of this column are determined from the product of the entries in column C and 
G. 

Tot Weight 
The final column indicates the total weight of the respective part. 

Sum 
At the bottom of the list, you find a summary showing the sums of column B, D, E, F and I. 
The data field in the column Tot Weight shows the amount of steel that is required. 

4.9 Parts List by Set of Members 

 
Figure 4.10: Table 4.2 Parts List by Set of Members 

The final STEEL table is displayed when sets of members have been selected for design. The 
advantage of the output by sets of members is the display of a summarized parts list for an 
entire structural group (for example a frame). 

Details on the table columns can be found in the previous chapter 4.8. When different 
cross-sections are used in the set of members, the program averages the surface area, the 
volume and the unit weight. 



5 Results Evaluation 

 

 

36 Program STEEL © 2011 Ing.-Software Dlubal 

5. Results Evaluation 
When the design is complete, several options are available for results evaluation. The but-
tons below the graphic can be helpful for the evaluation process. 

 
Figure 5.1: Buttons for results evaluation 

The buttons are reserved for the following functions: 

Button Description Function 

 Stress diagram 
Turns on and off the graphic display of stresses on the 
cross-section 

 Ratio 
Turns on and off the graphic display of stress ratios on 
the cross-section 

 Values 
Switches on and off the display of values in the stress 
or stress ratio graphic 

 
Cross-section out-
lines 

Displays the cross-section's shape in the cross-section 
graphic 

 Stress points 
Turns on and off the display of stress points in the 
cross-section graphic 

 Numbering Switches on and off the numbering of stress points 

 Cross-section info 
Opens the dialog box Info about cross-section showing 
the properties of the currently selected cross-section  
 Figure 4.2, page 27 

 Result diagrams 
Opens the window Result Diagram on Member  
 Chapter 5.4, page 44 
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 Show Color Bars 
Turns on and off the colored relation scales in the re-
sults tables 

 Exceeding 
Displays only the rows where the ratio is more than 1, 
thus the design is failed 

 Stress selection 
Opens the dialog box Stresses - Filter  
 Chapter 5.1, page 37 

 
Extended Stress 
Diagram 

Opens the dialog box Cross-section Values and Stress 
Diagram  Chapter 5.2, page 38 

 Full view 
Resets the stress graphic in full view (zooming is poss-
ible by using the wheel button, moving by drag-and-
drop) 

 View mode 
Jumps to the RSTAB work window to change the view 
 Chapter 5.3, page 40 

 Member selection 
Enables the selection of a member in the RSTAB win-
dow to display its stresses in the table 

Table 5.1: Buttons of results tables 2.1 to 2.5 

5.1 Selection of Stresses 
Subsequent to the design, the following stress types are preset in the results tables: 

• Normal stress σtotal 

• Shear stress τtotal 

• Equivalent stress σeqv 

Use the button [Select Stresses to Show] to activate further stress components. In this way, 
you can check the components affecting the total stress. 

 
Figure 5.2: Button Select Stresses to Show 

The dialog box Stresses - Filter appears where you can select the stress components. 

 
Figure 5.3: Dialog box Stresses - Filter 

The different stresses are described in Table 3.1 and Table 3.2 on page 21 and 23. 
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The two dialog buttons facilitate the selection. They are reserved for the following func-
tions: 

Button Description Function 

 Select all All stress components are selected. 

 Deselect all All stresses are canceled. 

Table 5.2: Buttons in the dialog box Stresses - Filter 

The analysis is carried out for each single stress point. Therefore, the components of the 
maximum stresses must not be summed up for a combined calculation (for example σtotal): 
Often, the maximum stresses occur at different stress points. You have to superimpose the 
stress components that are available on the same stress points. 

The selection made in the dialog box Stresses - Filter affects also the printout report. The 
printout includes the stress components that are active in the tables. 

5.2 Results on Cross-section 
In addition to the stresses listed in tables, a stress graphic is displayed to the right of the re-
sults tables. The graphic is dynamic, that means it shows the stress diagram of the current 
x-location or stress point that is determined by the pointer position in the table to the left. 
The currently selected stress point is highlighted in red in the graphic. 

 
Figure 5.4: Diagram of normal stresses on cross-section 

Use the wheel button to maximize or minimize the display. Use the drag-and-drop function 
to move the stress graphic. The button [Show All Graphic] resets the graphic's full view. 

The functions of the buttons below the graphic are described in Table 5.1 on page 37. The 
buttons control the graphic display with regard to 

• the stress or stress ratio diagram including values 

• the cross-section outlines 

• the stress points and their numbering. 

To evaluate the stresses for each stress point in detail, use the button [Show or Print Cross-
section Values and Extended Stress Diagram]. The dialog box Cross-section Values and 
Stress Diagram opens. 
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Figure 5.5: Dialog box Cross-section Values and Stress Diagram 

The current Member No. and the location x on the member are already preset in the dialog 
section Position. To select another member or x-location, use the list. 

The dialog section Stress Points lists the stress points of the cross-section. The two Coordi-
nates columns show the respective centroidal distances y and z. The Static Moments col-
umns display the static moments Qy and Qz. The final column indicates the Thickness t of 
the cross-section part which is required to determine the shear stresses. 

In the Stresses dialog section, the stress components are displayed for the stress point that 
is currently selected in the dialog section above. To visualize a particular stress component 
in the dynamic graphic on the right, select it by clicking the relevant entry. 

Most of the buttons below the graphic are identical with the buttons in the results tables 
(see Table 5.1, page 37). As usual, they are described by ScreenTips. The [Print] button 
enables the printout of the current stress graphic on the cross-section. For more informa-
tion, see chapter 6.2.1 on page 47. 
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5.3 Results in the RSTAB Model 
To evaluate the design results, you can also use the RSTAB work window. 

RSTAB background graphic and view mode 
The RSTAB graphic in the background may be useful when you want to check the position 
of a particular member in the model. The member that is selected in the STEEL results table 
is highlighted in the selection color in the RSTAB background graphic. In addition, an arrow 
indicates the member's x-location that is displayed in the active STEEL table row. 

 
Figure 5.6: Indication of the member and the current Location x in the RSTAB model 

If you move the STEEL window to another place in the display and you still cannot see the 
graphic clearly, use the button [Jump to Graphics] to activate the view mode: The STEEL 
window will be hidden so that you can adjust the view in the RSTAB user interface appro-
priately. The view mode provides the functions of the View menu, for example zooming, 
moving or rotating the display. 

Click [Back] to return to the add-on module STEEL. 
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RSTAB work window 
It is also possible to visualize the stresses and stress ratios directly in the structural model: 
Click the [Graphic] button to quit the STEEL module. Now, the individual design results like 
the internal forces or deformations of a RSTAB load case are displayed in the RSTAB work 
window. 

The Results navigator is aligned with the results from the add-on module STEEL. You can 
choose several stress components as well as the stress ratios in relation to the respective 
stress components. 

 
Figure 5.7: Results navigator 

To turn the display of design results on or off, use the button [Results on/off] shown on the 
left. To display the result values in the graphic, use the toolbar button [Show Result Values] 
to the right. 

As the RSTAB tables are of no relevance for the evaluation of STEEL results, you may deacti-
vate them. 

The design cases can be set as usual by means of the list in the RSTAB menu bar. 
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The graphical representation of results can be set in the Display navigator, by opening Re-
sults and selecting Members. Stresses and stress ratios are two-colored by default. 

 
Figure 5.8: Display navigator: Results → Members 

The representation of stresses is conforming to signs: Positive stresses are displayed in blue, 
in direction of the positive member axis z. Negative stresses are red, applied in opposite di-
rection. Therefore, it is possible that the stress diagram on the member, in case of disconti-
nuity for example due to concentrated loads, changes the sign and thus color and side. 

In case of a multicolor representation (options Cross-sections or Colored), the color panel is 
available, providing common control functions. The panel functions are described in detail 
in the RSTAB manual, chapter 4.4.6, page 67. 

 
Figure 5.9: Stress ratios due to bending moments My with display option Cross-sections 
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In the Factors tab, you can scale the design results, as you know it from the member inter-
nal forces. If you enter the factor 0 in the input field Member Diagrams, the results will be 
represented without scaling but with an increased line thickness. 

 

Figure 5.10: Panel tab Factors  

The graphics can be transferred like RSTAB graphics to the printout report (see chapter 
6.2.2, page 49). 

To return to the STEEL module, use the [STEEL] button in the panel. 
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5.4 Result Diagrams 
The result diagram can be useful if you want to see a member's result distribution displayed 
graphically. Select the member (or set of member) in the STEEL results table by placing the 
pointer in the corresponding table row and open the result diagram by clicking the button 
shown on the left. You find the button below the stress graphic (see Figure 5.1, page 36). 

The result diagrams are available in the RSTAB graphic. To display the diagrams, 

select Result Diagrams on Selected Members on the Results menu, 

or use the button in the RSTAB toolbar shown on the left. 

A window opens showing the distribution of the results on the selected member or set of 
members. 

 
Figure 5.11: Dialog box Result Diagram on Member 

In the navigator on the left, you can select the stresses and stress ratios that you want to be 
displayed in the result diagram. Use the list in the toolbar above to choose the relevant 
STEEL design case. 

For more detailed information on the dialog box Result Diagram on Member, see the RSTAB 
manual, chapter 9.8.4, page 205. 
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5.5 Filter for Results 
In addition to the results tables which already allow for a particular selection according to 
certain criteria because of their structure, you can use the filter options described in the 
RSTAB manual to evaluate the STEEL design results graphically. 

Generally, you can take advantage of already defined partial views (see RSTAB manual, 
chapter 9.8.6, page 209) used to group objects appropriately. 

Filtering designs 
The stresses and stress ratios can be used easily as filter criteria in the RSTAB work window. 
To apply this filter function, the panel must be displayed. If the panel is not active, 

select Control Panel (Colour scale, Factors, Filter) on the View menu 

or use the toolbar button shown on the left. 

The panel is described in the RSTAB manual, chapter 4.4.6, page 67. The filter settings for 
the results must be defined in the panel tab Color spectrum. As this tab is not available for 
the two-colored results display, you have to set the display option Colored or Cross-sections 
in the Display navigator. 

 
Figure 5.12: Filtering equivalent stresses with adjusted color spectrum 

If you use a colored results display, you can use the panel to define that only equivalent 
stresses for example larger than +110 N/mm2 are displayed. Furthermore, the color spec-
trum can be adjusted in such a way that a color range covers exactly 10 N/mm2 as shown in 
the figure above. 
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When you select the option Display Hidden Result Diagram (under Results → Members in 
the Display navigator), you can even display all stress diagrams that do not fulfill the condi-
tions. Those diagrams will be represented by dotted lines. 

Filtering members 
In the Filter tab of the control panel, you can define he numbers of the members whose re-
sults should be shown exclusively, which means filtered. The function is described in detail 
in the RSTAB manual, chapter 4.4.6, page 70. 

 
Figure 5.13: Filtering members: normal stresses of a frame 

Unlike the partial view function, the structure is now displayed completely in the graphic. 
The figure above shows the normal stresses of a frame inside a hall. The remaining de-
signed members are displayed in the model, but are shown without stresses. 
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6. Printout 
 

6.1 Printout Report 
Similar to RSTAB, the program generates a printout report for the STEEL results that can be 
added by graphics and descriptions. In the report you also decide which results will finally 
appear in the printout. 

The printout report is described in detail in the RSTAB manual. In particular, chapter 
10.1.3.4 Selecting Data of Add-on Modules on page 227 provides information concerning 
the selection of input and output data in add-on modules. 

For complex structures with a high number of design cases, it is recommended to split the 
data into several small printout reports which allows for a clearly-arranged printout and a 
faster work. 

The printout report only shows the stress types that are active in the STEEL design case for 
the results tables. For example, if you want to print the stresses due to axial force, activate 
the stresses σN in the STEEL add-on module (see chapter 5.1 Selection of Stresses, page 37). 

6.2 Print STEEL Graphics 
In addition to the graphical results evaluation, it is possible to provide the stresses and de-
sign ratios on the cross-section as well as in the RSTAB model for the printout. The graphics 
can be either integrated in the printout report or sent directly to the printer. Printing graph-
ics is described in detail in the RSTAB manual, chapter 10.2. 

6.2.1 Results on Cross-section 
The access to the print function is not directly available. Instead, open the dialog box Cross-
section Values and Stress Diagram (see Figure 5.5, page 39) by using the button [Show or 
Print Cross-section Values and Extended Stress Diagram] available in each results table. 

 
Figure 6.1: Button Show or Print Cross-section Values and Extended Stress Diagram in the graphic of the results tables 
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In the dialog box Cross-section Values and Stress Diagram (see Figure 5.5, page 39), specify 
the member, the relevant x-location and the type of stress for which you want to print the 
diagram. With the [Print] button in the bottom right corner of the dialog box, you open the 
following printing dialog box. 

 
Figure 6.2: Dialog box Print Info about Cross-section 

In the dialog section Print Type, the common options from RSTAB are available for selection: 

• Direct to Printer sends the current graphic to the printer. 

• To Printout Report inserts the graphic into the printout report. 

• To Clipboard provides the graphic for other applications. 

If several printout reports are available, you can select the number of the target report in 
the selection field to the right. 

In the dialog section Printout Selection, you decide which elements appear in the print 
graphic and in the output table. The objects specified under Create Graphics of Cross Sec-
tion do not require any further explanation. If you tick the check box for Cross-section 
Properties, the properties will be printed as a table, optionally added by a symbolic Info Pic-
ture in the margin. In the same way, you can integrate the properties of the Stress Points 
and c/t-Parts as well as the Stresses in All Stress Points in the printout. 

If you want to import several graphics consecutively into the printout report, clear the check 
box Show Printout Report on [OK]. 

 
Figure 6.3: Stress graphic in the printout report 
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6.2.2 Results in the RSTAB Model 
Every picture that is displayed in the graphic window of the main program RSTAB can be in-
cluded in the printout report. Thus, the stresses and ratios displayed in the RSTAB model 
can be prepared for the printout, too. 

Designs in the RSTAB model 
To print the STEEL graphic currently displayed in the RSTAB work window, 

select Print on the File menu 

or use the toolbar button shown on the left. 

 
Figure 6.4: Button Print in the toolbar of the main window 

Result diagrams 
In the same way, you can integrate the result diagrams of members into the report by using 
the [Print] button. It is also possible, to print them directly. 

 
Figure 6.5: Button Print in the toolbar of the Result Diagram window 

The following dialog box opens: 

 
Figure 6.6: Dialog box Graphic Printout, tab General 

This dialog box is described in detail in the RSTAB manual, chapter 10.2, page 243. The 
RSTAB manual also describes the Options and Color Spectrum tab. 
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A STEEL graphic that has been integrated in the printout report can be moved anywhere 
within the report by using the drag-and-drop function. In addition, it is possible to adjust 
imported graphics subsequently: Right-click the relevant entry in the navigator of the prin-
tout report and select Properties in the context menu. The dialog box Graphic Printout ap-
pears again, offering various options for adjustment. 

 
Figure 6.7: Dialog box Graphic Printout, tab Options 
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7. General Functions 
The final chapter describes some menu functions as well as export options for the design 
results. 

7.1 STEEL Design Cases 
You can group members in separate design cases. In this way you can, for example, com-
bine groups of structural components or define particular design specifications for them 
(limit stresses, partial safety factors, optimization etc.). 

It is no problem to analyze the same member or set of member in different design cases. 

The STEEL design cases are available in the RSTAB work window and can be displayed like a 
load case or load group by means of the toolbar list. 

Create a new STEEL case 
To create a new design case, 

select New Case on the File menu in the STEEL add-on module. 

The following dialog box appears. 

 
Figure 7.1: Dialog box New STEEL-Case 

In this dialog box, enter a No. (which is not yet assigned) and a Description for the new de-
sign case. When you click [OK], table 1.1 General Data opens where you can enter the new 
design data. 

Rename a STEEL case 
To change the description of a design case subsequently, 

select Rename Case on the File menu in the STEEL add-on module. 

The dialog box Rename STEEL-Case appears. 

 
Figure 7.2: Dialog box Rename STEEL-Case 
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Copy a STEEL case 
To copy the input data of the current design case, 

select Copy Case on the File menu in the STEEL add-on module. 

The dialog box Copy STEEL-Case appears where you can specify the number and description 
of the new case. 

 
Figure 7.3: Dialog box Copy STEEL-Case 

Delete a STEEL case 
To delete design cases, 

select Delete Case on the File menu in the STEEL add-on module. 

In the dialog box Delete Cases, you can select the relevant design case in the Available Cas-
es list to delete it by clicking [OK]. 

 
Figure 7.4: Dialog box Delete Cases 
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7.2 Cross-section Optimization 
As mentioned in chapter 2.3, STEEL offers you the possibility to optimize cross-sections. Se-
lect the relevant cross-section by ticking its check box in column C or D in table 1.3 Cross-
sections (see Figure 2.5, page 15). 

You can also start the cross-section optimization out of the results tables by using the con-
text menu. 

During the optimization process, STEEL determines the cross-section within the same cross-
section table that fulfills the analysis requirements in the most optimal way, that means 
comes as close as possible to the maximum possible ratio specified in the Details dialog box 
(see Figure 3.1, page 18). The required cross-section properties will be determined with the 
RSTAB internal forces. If a cross-section proves to be more favorable, two cross-sections will 
be displayed on the right of table 1.3 as shown in Figure 7.6, the original cross-section from 
RSTAB and the optimized one. 

For parameterized cross-sections of the cross-section library, a dialog box with detailed spe-
cifications appears when you tick the check box for optimization. 

 
Figure 7.5: Dialog box Welded Cross-sections - I symmetric : Optimize 

By ticking the check boxes in the Optimize column, you decide which parameter(s) you 
want to modify. The ticked check box enables the Minimal and Maximal columns where you 
specify the upper and lower limits of the parameter. The Increment column determines the 
interval in which the size of this parameter varies during the optimization process. 

If you want to Keep Current Side Proportions, tick the corresponding check box. Additional-
ly, you have to select at least two parameters for optimization to make the specification ef-
fective. 

For cross-sections based on combined rolled cross-sections, no optimization options are 
available. 

Please note for the optimization process that the internal forces won't be recalculated au-
tomatically with the changed cross-sections. It is up to you to decide which cross-sections 
should be transferred to RSTAB for a recalculation. As a result of optimized cross-sections, 
internal forces may vary considerably because of the changed stiffnesses in the structural 
system. It is recommended to recalculate the internal forces after the first optimization and 
then to optimize the cross-sections again. 
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You do not need to transfer the modified cross-sections to RSTAB manually: Set table 1.3 
Cross-sections, and then  

select Export All Cross-sections to RSTAB on the Edit menu. 

Also the context menu in table 1.3 provides options to export optimized cross-sections to 
RSTAB. 

 
Figure 7.6: Context menu in table 1.3 Cross-sections 

Before the changed cross-sections are transferred to RSTAB, a security query appears, be-
cause the transfer requires the deletion of results. When you confirm the query and start 
the calculation subsequently in the STEEL add-on module, the RSTAB internal forces as well 
as the stresses will be determined in one calculation run. 

 
Figure 7.7: Query before transfer of modified cross-sections to RSTAB 

By using the menu functions described above, you can also import the original RSTAB cross-
sections to STEEL. Please note that this option is only available in table 1.3 Cross-sections. 

If you optimize a tapered member, the program modifies the member's start and end and 
interpolates the second moments of area for the intermediate locations linearly. As these 
moments are considered with the fourth power, the stress analysis may be inaccurate if the 
depths of the start and end cross-section differ considerably. In this case, it is recommended 
to divide the tapers into several single members whose start and end cross-sections have 
minor cross-section differences. 
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7.3 Material Export to RSTAB 
When you have changed materials in the STEEL table 1.2, you can export the modified ma-
terials to RSTAB, similar to the export of modified cross-sections. It is also possible to import 
the originally used materials from RSTAB. Materials modified in the add-on module are hig-
hlighted in blue. 

You do not need to transfer the modified materials manually to RSTAB. 
Set table 1.2 Materials and then 

select Export All Materials to RSTAB on the Edit menu. 

Also the context menu of table 1.2 provides options to transfer modified materials to 
RSTAB. 

 
Figure 7.8: Context menu of table 1.2 Materials 

Before the changed materials will be transferred to RSTAB, a security query appears, be-
cause the transfer requires the deletion of results. When you confirm the query and start 
the calculation subsequently in the STEEL add-on module, the RSTAB internal forces as well 
as the design will be determined and performed in one single calculation run. 

 
Figure 7.9: Query before transfer of modified materials to RSTAB 
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7.4 Units and Decimal Places 
The units and decimal places for RSTAB and all add-on modules are managed in one global 
dialog box. In the add-on module STEEL, you can use the menu to define the units. To open 
the corresponding dialog box, 

select Units and Decimal Places on the Settings menu. 

The following dialog box opens, which you already know from RSTAB. The add-on module 
STEEL is preset. 

 
Figure 7.10: Dialog box Units and Decimal Places 

The settings can be saved as user profile to reuse them in other structures. The correspond-
ing functions are described in the RSTAB manual, chapter 11.6.2, page 336. 

7.5 Export of Results 
The results of the stress analysis can be provided for other programs in various ways. 

Clipboard 
To copy cells selected in the STEEL results tables to the clipboard, use the keyboard keys 
[Ctrl]+[C]. To insert the cells, for example in a word processing program, press [Ctrl]+[V]. 
The headers of the table columns won't be transferred. 

Printout report 
The data of the STEEL add-on module can be printed into the global printout report (see 
chapter 6.1, page 47) to export them subsequently. Then, in the printout report, 

select Export to RTF File or BauText on the File menu. 

The function is described in detail in the RSTAB manual, chapter 10.1.11, page 239. 
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Excel / OpenOffice 
STEEL provides a function for the direct data export to MS Excel, OpenOffice.org Calc or the 
file format CSV. To open the corresponding dialog box, 

select Export Tables on the File menu in the STEEL add-on module. 

The following export dialog box appears. 

 
Figure 7.11: Dialog box Export - MS Excel 

When you have selected the relevant parameters, start the export by clicking [OK]. Excel or 
OpenOffice will be started automatically. It is not necessary to run the programs in the 
background. 

 
Figure 7.12: Result in MS Excel: Table 2.1 Stresses by Cross-section
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